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บทที่ 1 
การเริ่มตนโปรแกรม Dreamweaver 

1. ขั้นตอนการเขาสูโปรแกรม 
วิธีการเขาสูโปรแกรมมีขั้นตอนดังนี ้

1. คล๊ิก                         ที่ Taskbar ดานลาง 
2. เลือกที่ Program > Macromedia >Macromedia Dreamweaver 8 โปรแกรมจะทํางาน และเปดหนาตาง
โปรแกรมขึ้นมา 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. โปรแกรมถูกเปดขึ้นแลว 
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สวนประกอบของโปรแกรม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
สวนที่ 1 เปดงานที่กําลังทําคางอยู โปรแกรมจะแสดงงานที่เปดใชบอยๆ ไวดานบน 
สวนที่ 2 เลือกประเภทงานทีต่องการสรางใหม ไดแก HTML, PHP, ASP, JavaScrip ฯลฯ 
สวนที่ 3 เลือกงานตามฟอรมที่โปรแกรมจดัไวใหโดยมีรูปแบบใหเลือกหลายประเภท 
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สวนที่ 4  เรียนรูโปรแกรมทางเว็บไซด  www.Macromedia.com 
สวนที่ 5 เรียนรูโปรแกรมจากโปรแกรมชวยสอน 
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2. หนาจอการทํางานหลักของโปรแกรม 

 หลังจากเลือกโปรแกรมเสร็จแลว จะพบกบัหนาตางการทํางาน ซ่ึงประกอบดวย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Title Bar คือ สวนที่แสดงชือ่โปรแกรม และช่ือไฟลที่กาํลังทํางานอยู 
2. Menu Bar คือ สวนที่รวมคําสั่งการทํางานทั้งหมด แลวแบงยอยตามประเภทและในคาํสั่งหลักมักจะมี

เมนูลัดใหกดดวย 
3. Object Palette คือ แถบแสดงปุมตางๆ ของโปรแกรม 

 
                                  
                                  สามารถเลือกประเภทคําสั่งไดดวยการคลิกที่ Common จะปรากฏเมนูขึ้นมา 
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• กลุมเครื่องมือ Common  เปนสวนที่รวบรวมเครื่องมือตางๆ ที่เรียกใชงานบอย ไดแก การแทรกภาพ 
การแทรกตาราง เปนตน 

 
 

• กลุมเครื่องมือ Layout เปนสวนที่รวบรวมเครื่องมือชวยในการจัดองคประกอบบนหนาเว็บ 
 
 

• กลุมเครื่องมือ Forms เปนที่รวบรวมเครื่องมือสําหรับที่ใชในการสรางแบบฟอรมสอบถาม และ
ตัวเลือกตาง ๆ  

 
 

• กลุมเครื่องมือ Text เปนที่รวบรวมเครื่องมือสําหรับจัดวาง และปรับแตงตัวอักษรบนหนาเว็บ 
 
 

• กลุมเครื่องมือ HTML เปนทีร่วบรวมเครื่องมือสําหรับจัดการภาษา HTML บนหนาเว็บ 
 
 

• กลุมเครื่องมือ Application เปนที่รวบรวมเครื่องมือสําหรับสรางแอพพลิเคชั่นติดตอกบัฐานขอมูล 
 
 

• กลุมเครื่องมือ Flash elements เปนเครื่องมือสําหรับนําองคประกอบที่สรางจากโปรแกรม Flash มา
วางบนหนาเวบ็ 

 
 

• กลุมเครื่องมือ Favorites สามารถเลือกเครื่องมือที่ใชบอยจากแตละกลุมเครื่องมือมาใสในเมนนูี้ได
ตามที่ตองการ 

 
 
 
 
 



 

 
6

กรมโรงงานอุตสาหกรรม 

Macromedia Dreamweaver  8

                                 ถาคลิ๊ก Show as Tabs การแสดงกลุมเครื่องมือจะเปลี่ยนเปนแท็บ 
 

 
 
4. Toolbar คือ แถบเครื่องมือสําหรับการใชงานดาน HTML และอินเตอรเน็ต ประกอบดวย 
 

•                        Show Code View แสดงการทํางานในรูปแบบ HTML 
 
•                      Show Code and Design Views แสดงการทํางานแบบ HTML ควบคูกับแสดง

พื้นที่ออกแบบ 
 

•                          Show Design View แสดงการทํางานแบบแสดงพื้นที่ออกแบบ 
 

•                                                                Document Title ตั้งชื่อของเว็บเพจ 
 

•               Check Errors ตรวจสอบขอผิดพลาดจาก Browser 
 

•                File Management จัดการกับไฟลๆ  ที่อยูในเว็บเพจ 
 

•                Preview / Debug in Brower ทดลองดูเว็บเพจของ Browser หรือกด F12 
 

•                View  Options มมุมองในการทาํงานเพิ่มเติม 
 

5. หนาตางออกแบบเว็บเพจ  ใชพิมพขอความและจัดเรียงรูปภาพ 
6. Tag Selector ใชควบคุมการทํางานในรูปแบบ HTML 
7. Window Size กําหนดพื้นทีใ่ชงานตามตองการ 
8. Estimate Download Time แสดงเวลา ที่ใชในการดาวโหลด 
9. Properties ใชกําหนดรูปแบบตางๆ ของตัวอักษร และรูปภาพ รวมถึงการสรางลิงก 
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หนาตาง Properties สามารถจะเปดปดไดตามตองการดวยการคลิกเครือ่งหมายถูกทีค่ําวา Properties 
 
 
 
 
 
 
 
 
 
 
3. วิธีการสราง Site 

 การสราง Site ก็เพื่อที่เวลาสรางเว็บไซต ขอมูลจะไดถูกจดัอยางเปนระเบียบ ไมกระจดักระจาย งายตอ
การตรวจสอบ วิธีการสรางก็งาย  
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4. การสรางขอความบน Dreamweaver 8 

 การสรางขอความ Dreamweaver 8 มีอยูดวยกัน 3 วิธี ดังนี้ 

1. พิมพขอความลงในสวนของหนาจอการทํางาน เปนวิธีที่งายที่สุด   
 
 
 
 
 
 
 
 
 

2. พิมพขอความจากโปรแกรมอื่น แลว copy มาใสที่หนาจอการทํางาน เปนอีกความสามารถหนึ่งของ 
Dreamweaver 8 ที่สนับสนุนการโอนยายขอมูลจากโปรแกรมอื่น เชน Word, Excel และ Notepad  โดยสามารถ
นํามาใสที่หนาจอการทํางานไดเลย และยงัแสดงผมไดเหมือนตนฉบบัอีกดวย 
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3. พิมพในรูปแบบการทํางานแบบ HTML ซ่ึงเหมาะสําหรับคนที่ถนัดภาษา HTML โดยคลิกที่                     
แลวพิมพขอความลงในสวน <BODY> หรือ  <HEAD> 

 
 
 
 
 
 
 
 
 
 
 
 

 
ขอควรจํา   ในเรื่องของการพิมพขอความ  ควรตรวจเรื่องของ Font ใหด ีเพราะบาง Font อานไทยไมได โดน
สามรถตั้งคาไดโดยการกด Ctrl + U แลวก็จะไดหนาตาง Preferences ดังรูป 
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วิธีการเปล่ียนรูปแบบตัวอักษร 
1. ลากเมาสขอความที่ตองการเปลี่ยน 
2. คลิกที่ Font เพือ่เลือก Font ที่ตองการ ควรเปน MS Sans Serif 
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การเปล่ียนขนาดตัวอักษร 
1. ลากเมาสขอความที่ตองการเปลี่ยนแปลง 
2. คลิกที่ Size เพื่อปรับขนาดตามตองการ 
3. ขนาดตัวอักษรจะเปลี่ยนไป 
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วิธีการเปล่ียนสีตัวอักษร 
1. ลากเมาสขอความที่ตองการเปลี่ยนแปลง 
2. คลิกที่ปุม Text color เพื่อเลือกสีที่ตองการ 
3. สีตัวอักษรไดเปลี่ยนสีไปตามที่ตองการ 
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การตกแตงและจัดรูปแบบขอความจากกลุมเคร่ืองมือ Text 
 
 
 

นอกจากนี้ในเมนู Text จะมคีําสั่งเพิ่มเติมในการตกแตงลักษณะตวัอักษร ตั้งแตการกําหนด
รูปแบบตัวอักษร ขนาด สี และสไตลของตัวอักษร 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- ขึ้นบรรทัดใหมแบบมีระยะหางของบรรทัดเยอะๆ ใหกด Enter 
- ขึ้นบรรทัดใหมแตตองการใหบรรทัดชิดกันใหกด Shift+Enter 
- การเวนวรรคใน Dream จะเว็นวรรคไดทีเดียว 

 การตั้งคาใหสามารถเวนวรรคได 
เลือก Menu Bar -- > Preferences... เมื่อเลือกแลวจะปรากฏหนาตาง Preferences 

 
 
 
 
 
 
 

       ตรง Alow Mutiple 
Consecutive Spaces  ซ่ึงจะ
ทําใหสามารถเวนวรรคได
ปกต ิ
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บทที่  2 
การเตรียมความพรอมกอนสรางเว็บไซต 

 
 กอนการสรางเว็บไซตจะตองเตรียมภาพหรอืขอมูลที่ใชเปนองคประกอบของหนาเวบ็แตละ
หนาไวกอน  
1. การสรางโฟลเดอรภาพหรือขอมูล 
 กรณีที่สราง Site เรียบรอยแลว ตองออกแบบจะมีโฟลเดอรยอยใน Site อะไรบาง  
ตัวอยางการสรางโฟลเดอรเก็บไฟลตางๆ  
  
 
 
 
  การสรางโฟลเดอรยอยใน dreamweaver 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- โฟลเดอรเก็บไฟลรูปภาพตางๆ 
-  เก็บไฟลขาวสารที่ประกาศในเว็บไซต 
- ไฟล  Homepage 

คลิกขวาตรงชื่อ Site และเลือก New Folder 

ปอนชื่อโฟลเดอรที่ตองการสราง 
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2.  การออกแบบโครงรางของหนา Web 
 องคประกอบของการออกแบบ Website อยางมีประสิทธิภาพ 
 - ความเรียบงาย ควรเปนเว็บไซตที่เรียบงาย ไมซับซอน และใชงานไดสะดวก อยาใช
ภาพเคลื่อนไหวมาก เพราะเปนการรบกวนสายตาและสรางความรําคาญแกผูใชได 
 - ความสม่ําเสมอ สรางความสม่ําเสมอใหกบั website  โดยใชรูปแบบเดยีวกันตลอดทัง้ website  
เพราะถามีความแตกตางกันมากจะสรางความสับสนใหผูใชไดวากําลังอยูในเว็บไซตเดิมหรือไม 
 - ความเปนเอกลักษณ  ตองคํานึงถึงลักษณะองคกร เชน Website ของธนาคารไมควรดู
เหมือนกับสวนสนุก การใชชุดสี ชนิดตัวอักษร รูปภาพ  ตองคํานึงถึงความเหมาะสมดวย 
 - เนื้อหาที่มีประโยชน  ควรจดัเตรียมเนื้อหาและขอมูลที่ผูใชตองการใหถูกตองและสมบูรณ 
 - ระบบงานทีใ่ชงานที่ถูกตอง  ระบบตาง ๆ ใน website ตองมีความแนนอนและใชงานไดจริง 
ตัวอยางเชน Link ตาง ๆ ตองถูกตองใชงานไดจริง 

- การแบงสวนของหนา Website 
   แบงหนา web ออกเปน 4 สวน 
 
 
 
 
   แบงหนา web ออกเปน 3 สวน 
 
 
 
 
   แบงหนา web ออกเปน 2 สวน 
 
 
 
 
 
3. เตรียมรูปภาพสําหรับ Website 
 รูปภาพที่จะนาํมาประกอบใน website สามารถสรางจากโปรแกรมตกแตงรูปภาพตาง ๆ  หรือ 
Download จากอินเทอรเน็ต 
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 เชน  การเตรียมภาพจากโปรแกรม Adobe Photoshop หรือการ Download จากอินเทอรเน็ต ซ่ึง
อาจจะใชพวก Search Engine มาชวยในการคนหาภาพในเว็บไซตได เชน  www.google.co.th 
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บทที่ 3 
การสรางตาราง 

 
 การสรางตารางโดยใชเครื่องมือ  
 
 
 
 
 
 
 
 
 
 
 
 
 
เมื่อกําหนดจํานวนแถวและคอลัมนเรียบรอยแลวกดปุม  
ซ่ึงจะไดตารางดังรูป 
 
 
 
 
 
 
การใสขอมูลในตาราง  
 สามารถใสขอมูลเขาไปในตารางที่สรางได โดยคลิกเลือกชองเซลลที่ตองการ แลวพิมพ
ขอความที่ตองการลงไป 
 
 
 

แถว 

คอลัมน 

Rows   จํานวนแถวทีต่องการ 
Columns  จํานวนคอลัมนที่ตองการ 
Table Width   ความกวางของตาราง 
Border thickness  ความหนาของขอบตาราง 
Cell padding   ระยะหางระหวางขอความ  
                              ภายในเซลลกับขอบเซลล 
Cell spacing   ระยะหางระหวางแตละ 
                              เซลลในตาราง 
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 สามารถปรับแตงขอความในตารางโดยใชเครื่องมือดังรูป 
 
 
 
การใสรูปภาพในตาราง  
 การแทรกภาพลงตารางและการปรับขนาดภาพใหพอดกีบัชองตารางที่ตองการ 

- เลือกใชเครื่องมือ   
- เลือกภาพที่ตองการจากนัน้กดปุม OK 

 
 
 
 
 
 
 
 
โปรแกรมจะถามกรณีที่ภาพอยูนอก site แนะนําใหตอบ Yes  เพื่อบันทกึไฟลรูปไวใน Site เวลา
เคลื่อนยายขอมูลไปเครื่องอื่นหรือที่อ่ืนไฟลรูปภาพจะไดไมหายไป 
 
 
 
 
 
 
 
 
 
ใสคําอธิบายรูปภาพ กรณีนําเมาสไปวางใกล ๆ จะแสดงขอความที่ปอนในชองของ Alternate text 
 
 
 

ควรเก็บไฟลรูปภาพไวในโฟลเดอร 
Images  จากนัน้กดปุม   
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การปรับแตงรายละเอียดของตาราง 
       กอนการปรับแตงตาราง ตองเลือกตารางที่ตองการปรับกอน ซ่ึงการเลือกตารางมีหลายวิธีดังนี ้
  เลือกแถว     เลือกคอลัมน 
 
 
 
 
 
 
 
เลือกทั้งตาราง ซ่ึงทําไดสองวิธี 
1. เลือกโดยคลิกตรงแถบสีเทาขางบนของตาราง  2. เลือกโดยคลิกตรงแท็คโคดของตาราง 
 
 
 
 
 
 
 
 
 
 
 
เคร่ืองมือในการปรับแตง 
 
 
 
 
 
 
 
 

รูปแบบตัวอักษร ตําแหนงการจัดวาง การเชื่อมโยง 

การรวมและแยกเซลล ขนาดของตาราง สีพ้ืนและสีเสนตาราง 
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การแทรกแถวและคอลัมน 
 คลิกเลือกแถวหรือคอลัมนที่ตองการแทรก จากนั้นคลิกขวาและเลือกคําล่ัง Table และเลือก
ตองการแทรกแถวหรือคอลัมน 
 
 
 
 
 
 
 
 
 
 
หรือเพิ่มจํานวนแถวหรือคอลัมนใน สวนของ Properties  แตการเพิ่มแบบนี้จะเปนการเพิ่มตอทายตาราง
ใหจะไมใชการแทรก 
 
 
 
 
การลบแถวและคอลัมน 
 เลือกแถวหรือคอลัมนที่ตองการลบ จากนัน้คลิกเมาสขวา และเลือกคําสั่ง Table และเลือกคําสั่ง 
Delete Row หรือ Delete Column 
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การรวมและการแบงเซลล 
 เพื่อจัดเรยีงขอมูลอยางเหมาะสม สามารถกําหนดใหรวมหรือแบงเซลลในตารางได 

การรวมเซลล 
1. เลือกเซลลที่ตองการจะรวม และตองเปนเซลลที่ติดกัน  
 

 
 
 
 
  

2. เมื่อเลือกเซลลเรียบรอยแลวกดที่เครื่องมือ 
 

 
 
 
 
 
 การแยกเซลล 
 การแบงเซลลในตารางออกเปนเซลลยอย สามารถทําไดดังนี ้
 1.  คลิกเมาสตรงเซลลที่ตองการจะแบง 
 
 
 
 
 
 
 2. คลิกปุมแยกเซลลดังรูป 
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 3. ปอนจํานวนเซลลที่ตองการแบง จากนัน้กดปุม OK 
 
 
 
 
 
การปรับความกวางและความสูงของตาราง 
 
 
 
 
 
 
 
 
 
 
การปรับความกวางและความสูงของเซลล 
 
 
 
 
 
การซอนตารางในเซลลตาราง 
 
 
 
 
 
 
 

สามารถเลือกวาจะแยกแถว (Rows) 
หรือคอลัมน (Columns) 

แสดงความกวางของตาราง 

ปรับขนาดของตาราง  
W (กวาง) H (สูง) 

หนวยที่ใชสามารถเปลี่ยนไดโดยกด
ตรงลูกศรและเลือกหนวยที่ตองการ 
ซ่ึงจะมีใหเลือก pixels หรือ % 

ปรับขนาดของเซลล  
W (กวาง) H (สูง) 

1. คลิกชองเซลลที่ตองการสราง
ตารางซอนขางใน 
2. คลิกเครื่องมือ  
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การตกแตงสีในตาราง 
 1. คลิกเลือกเซลลที่ตองการตกแตงส ี
 
 
 
 
 
 2. เลือกสีในเครื่องมือดังรูป 
 
 
 
 
 
 
 
 
 กรณีตองการใสสีทั้งตารางใหเลือก ทั้งตารางกอนแลวจึงใสพื้นหรือขอบตาราง 

3. กําหนดจํานวนแถวและคอลัมน 
เชน ตัวอยาง 5 แถว และ 1 คอลัมน 

4. ตัวอยางผลลัพธการซอนตาราง
ในเซลล 

ตกแตงสีพื้น สีเสนตาราง 
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การใสรูปภาพเปนพื้นของตาราง 
  สามารถใสภาพเปนพื้นหลังของตารางไดโดยเลือกเครื่องมือ ดังรูป 
 
 
 
 
 เลือกเครื่องมือ  เพื่อไปเลือกภาพที่ตองการทําเปนพื้นหลังของตาราง 
 
 
 
 
 
 
 

ผลลัพธการใสภาพเปนพื้นหลังของตาราง 
 
 
 
 
 
 
 
 
การปรับเสนขอบของตาราง 
 
 
 
 
 
Cell Pad ระยะหางระหวางขอความกบัเสนขอบตาราง 
Cell Space ขนาดของเสนขอบตาราง 
Border  กําหนดความหนาของเสนตาราง    ถาตั้งคาเปนเลขศูนย คือไมมีเสนตาราง 
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บทที่  4 
การเชื่อมโยง (Link) 

 
 การเชื่อมโยงมหีลายรูปแบบ โดยจะแบงการเชื่อมโยงดังนี้ 

1. การเชื่อมโยงภายในเว็บเพจหนาเดียวกนั 
2. การเชื่อมโยงภายในเว็บไซตเดียวกัน 
3. การเชื่อมโยงไปยังเว็บไซตอ่ืน 
4. การเชื่อมโยงดวยอีเมล 
5. การเชื่อมโยงไปยังไฟลดาวโหลด 
6. การเชื่อมโยงดวย Map link 
7. การเชื่อมโยงดวย RollOver Image 

 
1.  การเชื่อมโยงภายในเว็บเพจหนาเดียวกัน 

การเชื่อมโยงหนาเว็บเพจ คือ การกําหนดสวนของขอความหรือรูปภาพที่ตองการ เพื่อเปนจุด
เชื่อมโยงไปยงัเนื้อหาจดุอื่นๆ ซ่ึงเนื้อหาทีจ่ะเชื่อมโยงไปอาจจะอยูภายในหนาเดียวกัน  คนละหนากันก็
ได หรืออาจจะอยูคนละเว็บไซตก็ได  

การเชื่อมโยงหนาเว็บเพจไดนั้น จะตองมกีารกําหนดจดุที่ใชสําหรับเชือ่มโยง (Link) เปนสวนที่
ใชเปนจดุเชื่อมโยง ไปยังเปาหมายปลายทาง ซ่ึงอาจจะเปนรูปภาพ สัญลักษณ หรือขอความก็ได 
นอกจากนี้จะตองมีการกําหนดเปาหมาย (Target) เปนสวนปลายทางหรือจุดที่ตองการใหเชื่อมโยงมาถึง 
จะอยูสวนใดของเอกสารก็ไดแลวแตผูเขียนเว็บไซตจะกาํหนด 
 
 
 
 
 
 
ขั้นตอน 

1. กําหนดจุด Anchor หรือที่ Link  จะกระโดดไปในหนาเว็บเพจนั้น โดยใชเครื่องมือ  
 2. ตั้งชื่อ Anchor ซ่ึงจะเปนชือ่ที่ใชในการอางอิงมายังจุดนี้ 
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3. การสราง Link ไปยังจดุที่ทําจุด Anchor ไว 
เชน   การทํา link เพื่อกลับขึ้นไปขางบนเวบ็เพจ กรณีที่อยูดานลางของเว็บเพจนั้นอยู   โดยการ
ทําเลือกขอความที่ตองการทํา Link  ดังรูป 
 

 
 
 
 จากนั้นใหพิมพในชอง Link โดยตองพิมพสัญลักษณ # กอนหนาชื่อ Link ที่ตั้งไว 
 
2.  การเชื่อมโยงภายในเว็บไซตเดียวกัน 
ขั้นตอน 

- เลือกขอความหรือรูปภาพทีต่องการทําเปน link 
- ตรง Property Inspector ใน Link คลิกปุม    เพื่อกําหนดไฟลที่ตองการเชื่อมโยง ถารู

สามารถพิมพตําแหนงทีเ่ก็บไฟลและชื่อไฟลในชอง link ไดเลย 
 
 
 

- เลือกไฟลที่ตองการเชื่อมโยง แลวกดปุม OK 
 
 
 
 
 
 
 
 
 
 
 - กําหนด Target 
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 _blank  เปดหนาเว็บใหมที่เชื่อมโยงไปยังอีกหนาตางบราวเซอรใหม 
 _parent  เปดหนาเว็บใหมที่เชื่อมโยงไปยังอีกหนาตางบราวเซอรเดิม 
 _self  เปดหนาเว็บใหมที่เชื่อมโยงในเฟรมเดิม 
 _top  เปดหนาเว็บใหมที่เชื่อมโยงในหนาตางบราวเซอรเดิม โดยจดัใหเต็มเฟรม 
 
 หมาเหตุ  ถาไมกําหนดจะเปนการเปดในหนาตางบราวเซอรเดิม 
 
3. การเชื่อมโยงไปยงัเว็บไซตอ่ืน 
ขั้นตอน 

- เลือกขอความหรือรูปภาพทีต่องการทํา link  
- พิมพช่ือ URL ลงในชอง link ดังรูป ซ่ึงตองทราบ URL ของเว็บไซตที่ตองการทํา link เชื่อมโยง

ไป และตองพมิพ http://   นําหนาเสมอ 
 
 
 
 
 
 
4.  การเชื่อมโยงดวยอีเมล 

โดยทั่วไปเพื่อใหผูที่มาเยีย่มชมเว็บ สามารถติดตอกลับได  โดยจะสราง link ไปยังอีเมลของ
เจาของเว็บ เมือ่ผูใชคลิกที่ link ก็จะสามารถเขียนอีเมลมาคุยกับเราได โดยไมตองเสยีเวลาพิมพช่ืออีเมล
แอดเดรส 
ขั้นตอน 

- เลือกขอความหรือ รูปที่ตองการทํา link 
 
 

- พิมพอีเมลในชอง link โดยจะตองมีรูปแบบ ดังนี้  mailto:ช่ืออีเมลแอดเดรส 
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หรือ ใชเครื่องมือ  
 
 ปอนขอความ และอีเมล  ดังรูป 
 
 
 
 
 
5.  การเชื่อมโยงไปยงัไฟลดาวโหลด 

โดยปกติทัว่ไปจะพบวาในเว็บไซตจะมีการใหบริการ Download เชน โปรแกรม หรือ
บทความตาง ๆ ได ซ่ึงไฟลเหลานี้สวนมากจะเปนไฟลประเภท zip , doc หรือ pdf 
ขั้นตอน 

- เลือกขอความหรือรูปภาพทีต่องการทํา link 
- ตรง Link คลิกปุม     
 
 

 
- เลือกไฟลที่จะให Download 
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6.  การเชื่อมโยงดวย Map link 
การเชื่อมโยงดวย Map link จะตองกําหนดขอบเขตของลิงกบนภาพ ซ่ึงสามารถใชเครื่องมือ 

 
 
ขั้นตอน 

- เลือกรูปที่ตองการจะทําแมบลิงก 
- เลือกเครื่องมือที่จะกําหนดบริเวณแมบลิงก ที่ตองการ (Hotspot) ตามรูปแบบที่ตองการ  

  สําหรับเลือก บริเวณ Hotspot เมื่อตองการยายตําแหนง 
  สําหรับกําหนดขอบเขต Hotspot เปนรูปสี่เหล่ียม 

 สําหรับกําหนดขอบเขต Hotspot เปนรูปวงกลม 
 สําหรับกําหนดขอบเขต Hotspot เปนรูปเหลี่ยมใดๆ 

  
 
 

- วาดขอบเขตลงบนรูปภาพ เพื่อกําหนดบริเวณ Map link 
 
 
 
 
 
 -  เมื่อกําหนดขอบเขตเรียบรอยแลว ใหทาํการเชื่อมโยง link  ซ่ึงการเชื่อมโยงก็จะเหมือนการ
เชื่อมโยงดวยวธีิอ่ืนๆ  
 
 
 
 
 การแกไข Map link 
 ตองใชเครื่องมือ   คลิกที่ map link ที่ตองการแกไข ซ่ึงสามารถแกไข link ปรับขนาด หรือ
ยายตําแหนงไปวางบนสวนอื่นของภาพได แตถาตองการลบ map link สามารถกดปุม Delete ออกได 
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7.  การเชื่อมโยงดวย RollOver Image 
เปนการสรางลูกเลนใหกับภาพบนหนาเวบ็เพจใหนาใชมากยิ่งขึ้น โดยเมื่อนําเมาสมาวาง

ที่รูปภาพ รูปภาพจะเปลี่ยนไปเปนอีกรูปหนึ่ง และเมือ่คลิกลงที่รูปภาพ ก็จะสามารถเชื่อมโยงไปยังเว็บ
เพจหรือรูปภาพตางๆ ได  โดยมีขั้นตอนตอไปนี ้การทํา Rollover Image ตองเตรียมรูปภาพไว 2 ภาพ 

1. เลือกบริเวณที่จะทํา RollOver Image 
2. คลิก          ที่แถบเครื่องมือ หรือคลิกเมนู Image>>Interactive Image จะปรากฎ ดงั

รูปใหคลิกปุม                    เพื่อเลือกภาพ  โดยตองเลือกภาพ 2 ภาพสําหรับการทํา RollOver 
 
 
 
 
 
 
 

ตัวอยาง 
 
 
 

 
 
 

8. กําหนดคุณสมบัติของการเชื่อมโยง 
ขอความบนหนาเว็บทีก่ําหนดการเชื่อมโยงเอาไว สามารถกําหนดรูปแบบของขอความที่ใช

เชื่อมโยงไดจากหนาตาง Page Properties โดยเลือกเมนู  Modify > Page  Properties 
 

 
 
 
 
 
 
 

ภาพแรกที่มองเห็น 
ภาพที่สองจะเปลี่ยนตอนเอาเมาสมาวาง 
ขอความแสดงตอนเอาเมาสมาเหนือรูป 
link ที่ตองการเชื่อมโยง 



 

 
35Macromedia Dreamweaver  8

กรมโรงงานอุตสาหกรรม 

  ซ่ึงสามารถกําหนดรายละเอยีดได ดังนี ้
 
 
 
 
 
 
 
 
 
 
 - Link font   กําหนดรูปแบบตัวอักษรทีเ่ปนลิงก 
 - Size    กําหนดขนาดของรูปแบบตัวอักษรที่เปนลิงก 
 - Link color   เลือกสีลิงกปกติ 
 - visited  links   เลือกสีลิงกที่ถูกผูใชคลิกไปแลว 
 - Rollover links   เลือกสีลิงกเมื่อผูใชนําเมาสมาอยูเหนือสวนนี ้
 - Active links   เลือกสีลิงกที่ถูกคลิก 
 - Underline style   กําหนดรูปแบบการขีดเสนใตขอความที่เปนลิงก 
        Always underline         ขีดเสนใตขอความที่เปนลิงกเสมอ 
        Never underline         ไมขีดเสนใตขอความที่เปนลิงก 
        Show underline only on rollover   ใหขดีเสนใตขอความที่เปนลิงกเมื่อผูใชนําเมาสวางสวนนี ้
        Hide  underline on rollover          ซอนเสนใตขอความที่เปนลิงกเมื่อผูใชนําเมาสวางสวนนี ้
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บทที่   5 
การสรางฟอรม 

 
ปจจุบันมีการใชฟอรมสําหรับกรอกขอมูลในเว็บเพจ เพือ่เก็บขอมูลตั้งแตรายละเอยีดเกี่ยวกับผู

ที่มาเยี่ยม การสมัครสมาชิก การสมัครงาน การตอบแบบสอบถาม การสงอีเมล หรือการแสดงความ
คิดเห็นในกระดานขาว   อีกทั้งยังเปนการสื่อสารและตอบสนองระหวางผูชมกับเว็บไซต   เปนตน 
 
 
 
 
 
 
 
 
 
 

เว็บไซตหลายเว็บมักจะมีสวนโตตอบกับผูใชหลายแบบ อยางนอยก็ในลักษณะของฟอรมตางๆ 
ซ่ึงในการทํางานสวนนี้ จําเปนตองอาศัยความสามารถดานโปรแกรมมากํากับ แตในขั้นตนนี้ผูที่สนใจก็
สามารถสรางสวนโตตอบ กบัผูใชไดโดยอาศัยเทคนิคการผสม Form กับคําสั่ง Mailto: ไดเชนกัน โดย
จะเปนการสรางฟอรมสงรายงานเขามายังอีเมลของผูพัฒนาผานคําสั่ง Mailto 
เคร่ืองมือ 
 
 
ขั้นตอน 

1) คลิกเมาส ณ ตําแหนงทีต่องการวางฟอรม 
2) เปลี่ยนแถบเครื่องมือ Object เปน Form โดยคลิกที่ปุม Control Menu ซ่ึงมีรูปรางเปนปุม

สามเหลี่ยมชี้ลง แลวเลือกรายการ Form 
3) คลิกเลือกเครื่องมือการสรางฟอรม       จะปรากฏเสนประสีแดง ณ ตําแหนงทีว่าง Cursor 

ดังรูป 
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การกําหนดรายละเอียดของฟอรม  (Form Properties ) จะมีรายการตางๆ ดังนี้ 
 
 
 
 
Form Name  :  ช่ือฟอรม ใชในการอางอิงเมื่อจะเขียนสคริบตควบคุม 
Action  :  เปน URL หรือที่อยูของโปรแกรมสคริบต เชน  http://www2.diw.go.th/sendemail.asp 
Method : วิธีในการสงขอมูล  

POST  คือ  การสงขอมูลภายในฟอรม ไปยังโปรแกรมสคริปต เพื่อประมวลผล โดยจะไมสงคา
ขอมูลการสง ผาน Address Bar ทําใหมั่นใจไดวาผูใชจะมองไมเห็นขอมูลที่สงออกไป จึงคอนขาง
ปลอดภัย 

GET คือ การสงขอมูลภายในฟอรม ไปยังโปรแกรมสคริปต เพื่อประมวลผล โดยจะสงคา
ขอมูลการสงผาน Address Bar  เชน   http://www.abc.com/view.php?name=wanchalong&txt=สวัสดี  
เปนตน  ทําใหสามารถมองเห็นขอมูลผานทางบราวเซอร Target  :  เปาหมายที่ผลลัพธแสดง 
Enctype  :  กําหนดการเขารหัส 
 
เคร่ืองมือในการสรางฟอรม 
1. ฟลดกรอกขอความ (Text Field)  สําหรับสรางสวนรับ แสดงขอมูลทั้งตัวอักษรและตัวเลข หรือ
รหัสผาน โดยคลิกที่เครื่องมือ   จะปรากฎหนาตางใหปอนรายละเอยีด ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 

ขอความหรือช่ือของ text field 
Style เลือกรูปแบบของขอความ 
เชน Wrap เปนการตัดขอความ 
 
 
Position ตําแหนงของขอความ
จะอยูกอนหรือลังชอง text field 
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การตั้งคา Properties ของ Text field 
 
 
 
TextField Name   กําหนดชือ่ฟลดใชในการประมวลผล  
Char Width    กําหนดความกวางของฟลดสําหรับกรอกขอความ มีหนวยเปนตัวอักษร  
 Max Chars    กําหนดจํานวนอักษรสูงสุดที่ยอมใหปอนในฟลด มหีนวยเปนตัวอักษร  
 Type             ประเภทของฟลดขอความ ไดแก  
    - แบบบรรทัดเดียว (Single Line)  

- แบบหลายบรรทัด (Multi Line)  
-แบบรหัสผาน (Password)  ซ่ึงจะแสดงเครื่องหมาย   *  เมื่อมีการปอนขอมูล
ในฟลดนี ้

 Init Val            ระบุขอความที่ตองการใหแสดงในฟลดนีทุ้กครั้งที่มีการแสดงผลผานเบราเซอร  
 Wrap             ควบคุมการตดัคําเมื่อเลือก Type เปน Multi Line 
 
ตัวอยาง 
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2. ปุมทางเลือกแบบเช็คบ็อกซ (Check Box) 
เปนปุมใหผูชมสามารถเลือก หรือยกเลิกสิ่งที่เลือกได โดยมีไดหลายตวัเลือก เหมาะสําหรับ

คําถามที่มีคําตอบไดหลายคําตอบ  ดังรูป 
 
 
 
ขั้นตอน 

- คลิกเมาส วางตําแหนงทีต่องการในฟอรม (Form)  
- คลิกเครื่องมือ      ในแท็บ Forms  หรือ คลิกเมนู Insert > Form > Check Box  
- ปรับแตงรายละเอียดของเครื่องมือตามความตองการ 

การกําหนดรายละเอียดของเช็คบ็อกซ (Check  Box Properties ) 
 
 
 
 

o Check Box    ใสช่ือตัวแปร  สําหรับเก็บคาที่ผูใชเลือก  
o Checked Value   กําหนดคาที่ใชรวมกับชือ่ตัวแปรของเช็คบ็อกซในการสงคาใหกับ

โปรแกรมสคริปตประมวลผล  
o Initial        กําหนดคาเริม่ตนให เลือก (Checked) /ไมเลือก (Unchecked 

 
3. ปุมทางเลือกแบบเรดิโอ (Radio Button) 

เปนปุมใหผูชมสามารถเลือกเพียงตัวเลือกเดียว มักใชกับคําถามที่ตองการคําตอบแบบ
เฉพาะเจาะจง โดยสามารถสรางไดทั้งแบบกลุมและแบบเดี่ยว 
 
 
 
ขั้นตอน 

- คลิกเมาส วางตําแหนงทีต่องการในฟอรม (Form)  
- คลิกเครื่องมือ     (กรณีเลือกแบบเดีย่ว) หรือ    (กรณีเลือกแบบกลุม) ในแท็บ Forms  

หรือ คลิกเมนู Insert > Form > Radio Button (Radio Group)  
-  ปรับแตงรายละเอียดของเครื่องมือตามความตองการ  
- การกําหนดรายละเอียดของ Radio Button (Radio Button  Properties )  จะมีรายการตางๆ ดังนี ้
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• Radio Button   ใสช่ือตัวแปร  สําหรับเก็บคาที่ผูใชเลือก  
• Checked Value   กําหนดคาที่ใชรวมกับชือ่ตัวแปรของตวัเลือกในการสงคาใหกับ

โปรแกรมสคริปตประมวลผล  
• Initial  กําหนดคาเริ่มตนให เลือก (Checked) /ไมเลือก (Unchecked) 
 

4. การสรางลสิตรายการ 
การสรางลิสตรายการจะใชในการเลือกสิ่งที่ตองการไดจากรายการ โดยมี 2 รูปแบบ ไดแก 
1. รายการแบบเมนู (Menu)  เหมาะสําหรับรายการขอมูลจํานวนมาก ขนาดของขอมูลไมมาก 

และใชพืน้ที่นอย เชน วัน เดอืน ป  เปนตน  
2. รายการแบบลสิต (List)  เหมาะสําหรับรายการขอมูลจํานวนมาก และสามารถเลือกขอมูล

ไดหลายคา เชน อาหารที่ชอบ  เปนตน 
 
 
 
 
 
การกําหนดรายละเอียดของรายการ (List/Menu  Properties )  จะมีรายการตางๆ ดังนี ้
 
 

 
• List/Menu   กําหนกชื่อตวัแปร  สําหรับเก็บคาที่ผูใชเลือก 
• Type   กําหนดแบบของรายการที่จะแสดง  

o Menu  แสดงรายการแบบเมนู (Menu)  
o List  แสดงรายการแบบลิสต (List)   
 

• Height  จํานวนบรรทัดของขอมูลที่แสดง   เมื่อผูชมคลิก  
 
 

กรณีเลือก list 
สามารถระบุจํานวนที่
จะแสดงรายการได 

ถา     สามารถเลือก
ไดหลายคา 
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• List Value...  กําหนดรายการขอมูล 
 
 
 
 
 
 
 

1. คลิกปุม    เพื่อเพิ่มลิสตรายการ  หรือ     เพื่อลบรายการ 
2. พิมพรายการลงในชอง Item Label เพื่อกาํหนดคาที่จะแสดง และ Value เพื่อกําหนดคาของ

ขอมูล  [คลิก  เมื่อตองการเปลี่ยนอันดับขอมูล] 
3. คลิกปุม OK 

 
 
 
 
 
 
 
 
 
5. กรอบสําหรับเลือกไฟล (File  Field) 

สําหรับใหผูชมสามารถเลือกไฟลเพื่อนําเขา (Upload) มาที่เว็บไซต โดยคลิกเลือกไฟลที่ 
ปุม                             เชน นาํเขารู ปภาพของสมาชิก 
ขั้นตอน 

• คลิกเมาส วางตําแหนงทีต่องการในฟอรม (Form)  
• คลิกเครื่องมือ     ในแท็บ Forms  หรือ คลิกเมนู Insert > Form > File Field  
• ปรับแตงรายละเอียดของเครื่องมือตามความตองการ 
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- FileField   ใสช่ือตัวแปร  สําหรับเก็บคาที่ผูใชเลือก  
- Char Width   กําหนดคาความยาวของกรอบเลือกไฟล  
- Max Chars  กําหนดจํานวนอักษรที่ชองรับไดสูงสุด 

 
ตัวอยาง 
 
 
 
6. การสรางปุมกด (Button) 

ในแบบฟอรมจะมีปุมกด หรือ Button สําหรับสงขอมูลที่กรอกในแบบฟอรมไปยังโปรแกรม
สคริปต CGI เพื่อนําไปประมวลผล หรือใชสําหรับยกเลกิขอมูลที่กรอกในแบบฟอรม เปนตน  
 
 
ขั้นตอน  

• คลิกเมาส วางตําแหนงทีต่องการในฟอรม (Form)  
• คลิกเครื่องมือ   ในแท็บ Forms  หรือ คลิกเมนู Insert > Form  > Button  
• ปรับแตงรายละเอียดของเครื่องมือตามความตองการ  
• การกําหนดรายละเอียดของปุมกด (File Field Properties )   

 
 
 

- Button Name   ใสช่ือตัวแปร  สําหรับเก็บคาที่ผูใชเลือก  
 - Label    กําหนดคาความยาวของกรอบเลือกไฟล  
 - Action กําหนดประเภทของ bottom  

 Submit form  
 Reset form  
 None 

ตัวอยาง 
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 สามารถนํารูปภาพมาทําเปนปุม submit ได  
ขั้นตอน 

• คลิกเมาส วางตําแหนงทีต่องการในฟอรม (Form)  
• คลิกเครื่องมือ   ในแท็บ Forms   
• เลือกไฟลรูปภาพที่ตองการมาทําปุม  เชน    

 
 
 
 
 
 
 
 
 
 
7. การตรวจสอบความถูกตองของขอมูล (Validate Form) 
 เปนการทํางานของ Behaviors ในโปรแกรมของ Dreamweaver โดยเลือกเมนูการทํางานที่ 
window > Behaviors  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เมื่อคลิกที่ตรง
เครื่องหมายบวกจะมี
เมนูยอยใหเลือก โดย
ใหเลือกที ่Validate 
Form 
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 เมื่อคลิกเลือก Validate Form จะปรากฎหนาตางดังรูป 
 
 
 
 
 
 

- Value    ตองมีคาเสมอ  
- Accept 

Anything ปอนขอมูลอะไรก็ได 
Number  ขอมูลเฉพาะตวัเลขเทานั้น 
Email address ขอมูลตองเปนรูปแบบ Email 
Number form ….  To  …..ขอมูลตัวเลขตองมีคาอยูในชวงที่กําหนด 

 
กลับมาที่หนาตาง Behaviors ใหดูวาตรง Events นั้นเปน OnSubmit หรือไม ถาไมใช

ใหทานกําหนดเปน OnSubmit การตรวจเช็คฟอรมถึงจะทาํงานได  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

จะมีรายการ text field ตางๆ 
ที่ทําไวใหเลือก 
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บทที่  6 
Behaviors หรือ Action  Script 

 
1. ทํา Window Popup โฆษณา หรือขาวประชาสัมพันธ 
คือการทําหนาตางเล็ก ๆ เปดขึ้นมาพรอมกบัหนา Home Page ดวย ซ่ึงหนาตางนัน้อาจจะไมมี

เมนู ไมมี Status Bar ไมมี Address ของ window ตามปรกติ  
 
 
 
 
 
 
 
 
 
 
 

ขั้นตอน  
1. ให New File ขึ้นมาใหม หรือจะใชเพจเดิมที่มีการออกแบบไวแลวก็ได 
เชน  เตรียมหนาโฆษณาดังรูป และเก็บไฟลช่ือ promotion.html 
 
 
 
 
 
 
2. เปดไฟลที่ตองการใหหนาโฆษณา แสดงขึ้นมาตอนที่เปดหนาไฟลนีข้ึ้นมา ซ่ึงโดยปกตินิยม

หนาแรกของเว็บไซต  เมื่อคนเขามาเว็บครัง้แรกก็จะแสดงหนาตางขาวสารหรือหนาโฆษณา 
- คลิกเลือก Tag Body   ดังรูป 
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- จากนั้นเลือกคลิกที่เครื่องหมายบวก และเลือก Open Browser Window   ดังรูป 
 
 
 
 
 
 
 
 

URL to Display : ใหกรอก URL ของเว็บเพจที่ทานจะทาํการเปดขึ้นมาพรอมกับเว็บเพจนี้ 
หรือ กรณีอยูในไซตเดยีวกันใหทานทําการ Browse...หาไฟลที่ตองการ 

Window Width & Window Height :: ใหทาํการกําหนดขนาดของหนาตาง window ที่จะเปด
ขึ้นมา 

Attributes ::            ตรงนี้จะเปนการกําหนดวา ทานตองการใหหนาตางที่เปดขึ้นมานัน้ มี
คุณสมบัติอะไรบาง ใหคลิกเลือก 

 - Navigation Toolbar  แถบปุมคําสั่ง 
 - Location Toolbar  แถบสําหรับใส URL 
 - Status bar   แถบสถานะ 
 - Menu bar   แถบเมน ู

- Scrollbars as Needed แถบเลื่อน ซ่ึงจะปรากฎเมื่อหนาเว็บที่แสดงมี
ความยาวกวาขนาดของหนาตางบราวเซอร 

 - Resize Handles  ใหผูใชปรับขนาดหนาตางได 
 - Window Name  กําหนดชื่อไวสําหรับอางอิง 
 Window Name ::   ตั้งชื่อหนาตางที่จะเปดขึ้นมา 

 
3. เมื่อ OK ไปแลวกก็ลับมาดูที่หนาตาง Behaviors อีกครั้ง เพื่อใหแนใจวากําหนดคาถูกตอง ให

ดูวาตรง Events ของ Open Window Browser นั้นเปน OnLoad   ถาไมเปนใหทําการเปลี่ยน Events เปน 
onLoad ดังรูป 
 
 
 
 - การแกไข สามารถดับเบิ้ลคลิกตรงแถบสีน้ําเงินเพื่อกลับไปแกไขรายละเอียดตางๆ ได 
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2. การทําปุมปด Windows 
 การทําปุมปดหนาตาง browser  ซ่ึงอาจจะนําไปประยุกตใชกับการใชกบั Window Popup 
 
 
 
 
 
 
 
 
ขั้นตอน 

1.นํา Cursor ไปวางในตําแหนงที่ตองการแลว ใหเปด Snippet Panel ขึ้นมา โดยไปที่ Main 
Menu -> Window -> Snippets ดังรูป 
 
 

 
 

 
 
 
 

2. เมื่อทําการเปด Snippets Panel ขึ้นมาแลว ใหไปที่หมวด Form Elements แลวทําการ click 
ไปที่เครื่องหมายบวก ( + ) หนารายการ Form Elements เพื่อทําการขยายหรือเปดรายการของ Form 
Elements ดังรูป  
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 3. จากนั้นใหทําการ Double-click ไปที่รายการ Close Window Button ดังรูป ก็จะไดปุมกด
สําหรับการปดหนาตาง Browser ที่ตําแหนงที่ทําการวาง cursor ไวในหนาเว็บเพจของ 
 
 
 
 

 
 
 
 4. ปรับแตง Properties ไดดังรูป 
 
 
 
3. การใสเสียงบนเว็บ (Play Sound) 
 เมื่อผูใชกระทาํบางอยางบนเว็บ เชน เล่ือนเมาสหรือเหนือปุมกด หรือใหเลนเพลงเมื่อโหลด
หนาเว็บนี้โดยไฟลเสียงที่จะใชเปน .midi, .wav เปนพื้นฐาน ถาเปนไฟลอ่ืนอาจจะตองติดตั้งโปรแกรม
เสริมใหกับบราวเซอรจึงจะเลนได 
ขั้นตอน 

 1.  คลิกเลือก Tag Body   ดังรูป 
 
 

  2.  คลิกเครื่องหมายบวกตรง Behaviors และเลือก Play Sound ดังรูป 
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  3. Brows หาเพลงที่ตองการ 
 
 
 
 
4 .แสดงกลองขอความ (Popup Message) 

ขั้นตอน 
 1. คลิกตรงเครื่องหมายบวกของ Behaviors 
 
 
 
 
 
 
 
 2. เมื่อเปดไฟลผาน browser จะแสดงกลองขอความดังรูป 
 
 
 
 
 
 
 
5. การทํา Popup Menu 
 ขั้นตอน 
 1. คลิกเลือกขอความหรือรูปภาพที่ตองการทํา Popup Menu 
   
 
 
 2. ตองพิมพเครื่องหมาย # ในชองลิงกกอนเสมอ จากนัน้ทําการบันทกึไฟล 
 
 
 

พิมพขอความที่ตองการใหแสดง 
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 3. คลิกเครื่องหมายบวกตรง Behaviors และเลือก Show Pop-up Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 4. เพิ่มเมนยูอย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

+ เพิ่มเมนู   - ลบเมนูออก 

ปรับเมนูยอย 

ช่ือไฟลหรือ URL ที่ตองการลิงก 
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 5. ปรับแตงสีของเมนู ในแถบเมนู Appearance 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.  ปรับแตงเมนูเพิ่มเติมใน Advanced 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 7. ปรับตําแหนงแสดงเมนูใน Position 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เลือกรูปแบบการจัดวาง
รายการเมนูในแนวตั้งหรือ
แนวนอน 

Up state สีตัวหนังสือและสี
พ้ืน ขณะที่เมาสยังไมผาน 
Over state สีตัวหนังสือ
และสีพ้ืน ขณะที่เมาสเลื่อน
ผาน

ปรับขนาดของเซลล 

เสนและสีของขอบเซลล 
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บทที่  7 
การทํางานเกี่ยวกับ Flash 

 
การแทรกไฟล Flash 

ขั้นตอน 
 1. กําหนดตําแหนงที่ตองการแทรกปุมกดในหนาเว็บเพจ 

2. คลิกปุม   จากแท็บ Media หรือเลือกคําสั่ง Insert>Media>Flash 
 
 
 

3. เลือกไฟล flash ที่ตองการ 
 
 
 
 
 
 
 
 4. ปรากฏสัญลักษณ    และทดสอบแสดงผล โดยกดปุม F12 
 
การสราง Images Slide Show 

สามารถสราง Image ในรูปแบบสไลดโชวเปนลักษณะ Flash  
 
 
 
 
 
 
 
1. ใหเตรียมรูปภาพที่จะนํามาทําเปน Slide ในจํานวนทีต่องการ 
2. เมื่อการจัดเตรียมรูปภาพแลว จากนัน้ใหทําการ New Flie ขึ้นมาและทําการ Save File  
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3. ไปที่ Insert  ฺBar เลือกไปที่ Flash elements TAB ดังรูป แลว Click ที่ Icon ที่ช่ือวา Image 
Viewer  
 
 
 

 
 
4. เมื่อ Click ไปที่ไอคอนดังกลาวแลว โปรแกรมจะให Save ไฟล Flash ที่กําลังจะสรางขึ้นมา 

ใหทําการ Save ไวที่ Site ที่กําหนดคาไว ดงัรูป 
 
 
 
 
 
 
 
5. เมื่อไดทําการ Save ไฟลเก็บไวแลว ที่โปรแกรม Dreamweaver  จะพบ ไฟล Flash เพิ่มขึ้นมา 

ซ่ึงจะมีลักษณะเปนพืน้ที่สีเทา และมีสัญลักษณของ Flash อยูตรงกลาง  ให Click เลือกที่พื้นที่นีไ้ว 
 
 
 
 
 
 
 
 
 
 
 
ที่ Flash elements Panel นี้ ตองทําการกําหนดคาตาง ๆ ที่จําเปนตอการใชงานลงไป ดังนี ้
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- bgColor : คาสีพื้นหลังของ Flash 
- captionColor : สีของชื่อรูปภาพ 
- frameColor : สีของเสนกรอบ 
- frameTrickness : ขนาดของเสนกรอบ 
- imageCaption : ช่ือรูปภาพในแตละรูป 
- imageLink : ไฟลหรือ URL ที่ราจะทําการ Link ไปเมื่อผูเขาชมเว็บ Click ไปที่รูปภาพ 
- imageURLs : ตําแหนงที่เกบ็ไฟลรูปภาพที่จะนํามาทําเปนสไลด 
- slideDelay : คาความหนวงเวลาในการเปลี่ยนรูปภาพแตละภาพ มหีนวยเปน วนิาที  
- transitionsType : รูปแบบเอ็ฟเฟคพิเศษทีจ่ะนํามาใชในระหวางการเปลี่ยนรูปภาพ  

     - showControls :  แสดงปุมเล่ือน slide หรือไม (Yes-แสดง  No-ไมแสดง) 
     - SlideAutoplay :  แสดงปุมเลื่อน slide หรือไม (Yes-แสดงอัตโนมตัิ  No-ไมแสดงอัตโนมัติ) 
 

6. จากคาคุณสมบัติตาง ๆ ขางตน สามารถกําหนดคาตาง ๆ ไดโดยการ Click ไปที่ชอง
คุณสมบัติ    นัน้ ๆ เชน หากคุณตองการใสรูปภาพเพื่อนํามาทําสไลดกับ Flash นี้ คุณสามารถทําการ 
Click ไปที่ชองคุณสมบัติทางขวามือของ Panel นั้นได ดังรูป 
 
 
 
  
เมื่อ Click แลวสําหรับการใสรูปภาพโปรแกรมจะทําการเปด Dialog ขึ้นมาใหทําการ Add รูปภาพได ดัง
รูป 
 
 
 
 
 
 
  

7. เมื่อกําหนดคาตาง ๆ ที่ตองการเสร็จสิ้น ให Save และทําการ Preview ดูผลกับ Web Browser 
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การสราง Flash text 
 นอกจากการสรางปุมกดบนหนาเว็บแลว Dreamweaver  สามารถสรางขอความที่เปนลิงก  ไดที่
เรียกวา Flash Text โดยเมื่อนําเมาสไปวางที่ขอความนั้น สีของขอความก็จะเปลี่ยนไป แลวเมื่อคลิกที่
ขอความก็จะเปนการเชื่อมโยงไปยังเว็บเพจหรือเว็บไซตอ่ืนได โดยขอความที่เปนลิงกนี้จะถูกสรางเปน
ไฟล Flash movie ซ่ึงจะดูสวยงามแตมีขนาดเล็กทําใหโหลดไดเร็ว 
ขั้นตอน 

1. กําหนดตําแหนงที่ตองการแทรกลิงกขอความในหนาเว็บเพจ 
2. คลิก Insert>Media>Flash Text 

 
 
 
 
 
 
 3. ปรับแตงรายละเอียด 
 
 
 
 
 
 
 
 
 
 

Font    กําหนดรูปแบบตัวอักษร  
Size  กําหนดขนาดตัวอักษร  
   กําหนดลักษณะตัวอักษรเปนตัวหนา หรือตวัเอียง  

 กําหนดตําแหนงตัวอักษร  
Color  กําหนดสีของตัวอักษร  
Rollover Color  กําหนดสีของตัวอักษรเมื่อผูใชนําเมาสไปวางอยูเหนือขอความนี้  
Text  พิมพขอความที่ตองการ  
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Link  กําหนดไฟลหรือ URL ที่ตองการใหขอความนั้นเชื่อมโยงไป  
Target  กําหนดลักษณะหนาตางเวบ็เพจหรือบราวเซอรที่ตองการเปดขึ้นมา เมื่อไดลิงก  
Bg Color    กําหนดสีพื้นหลังใหกับขอความ  
Save As    กําหนดชื่อไฟลที่จะบันทึกไฟล Flash Text 

 
การทํา Flash Button 
 ขั้นตอน 

1. กําหนดตําแหนงที่ตองการแทรกลิงกขอความในหนาเว็บเพจ 
2. คลิก Insert>Media>Flash button 

 
 
 
 
 
 3. ปรับแตงรายละเอียด 
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บทที่  8 
การสราง Layer 

 
เปนเครื่องมือที่ใชสําหรับสรางกลองขอความ แตยังสามารถนําวัตุอ่ืนมาใสใน Layer ไดอีกดวย 

เชน ตาราง, รูปภาพ, ขอความตางๆ แตการใช Layer โปรแกรมที่ใชดูเวบ็ตองเปน Internet Explorer 
ตั้งแต version 4 ขึ้นไป ดังนัน้จะไมคอยใช Layer มาใชในหนาเว็บหลักๆ  

เคร่ืองมือ 
 
 
การสราง Layer 
ขั้นตอน 

1. สรางเอกสารที่ตองการสราง Layer ขึ้นมา 
2.  หลังจากนัน้ใหเลือกเครื่องมือ Draw Layer   หลังจากที่คลิกแลวใหนํา Mouse ไปวาดที่

ช้ินงาน ดังรูป 
 
 
 
 
 
 
 
 
 3. พิมพขอความหรือแทรกรปูภาพใน Layer 
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4. แตถาตองการยาย Layer ใหคลิกที่ขอบของ Layer ดานไหนกไ็ด หลังจากนั้น Click ที่      
ของLayer แลวทําการยายไดเลย 

 
 
 
 
 
 
 

5. หรือจะยายที่เครื่องมือ Properties ก็ไดแตตองคลิกที่ขอบกอนเหมือนกัน ดังรูป 
Properties Layer 

-  การยายในแนวนอน 
-  การยายในแนวตั้ง 
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บทที่  9 
การสรางเฟรม 

 
การใชเฟรมเซต (Frame Set) เปนรูปแบบหนึง่ของการนําเสนอผลงานผานหนาเว็บเพจ 

ออกเปนสวนยอย ที่เรียกวา เฟรม ทําใหสามารถใชพื้นทีท่ั้งหมดบนหนาจอไดอยางมีประสิทธิภาพ โดย
แตละเฟรมนัน้จะแสดงหนาเว็บที่แตกตางกัน เชน กําหนดสวนบนสุด (topFrame) แสดงชื่อโลโกของ
เว็บไซต หนาจอดานซาย (leftFrame) แสดงขอความตางๆ เพื่อเปดดเูว็บเพจหนาอืน่ๆ หรือสวนดานขวา 
(mainFrame) แสดงเนื้อหาทีเ่กิดจากการคลกิในสวน leftFrame 

 
 
 
 
 
 
 
 
 
 
 

 
ขอดี คือ สําหรับจัดแบงพืน้ที่บนหนาเว็บเพจออกเปนสวนๆ ใหเปนอสิระตอกัน โดยสามารถ

จัดแบงเฟรมไดทั้งในแนวตั้งและแนวนอน เมื่อนําไปแสดงผลบนบราวเซอรขอมูลที่ปรากฏขึ้นมาก็จะ
ถูกจัดแบงออกเปนสัดสวนอยางชัดเจน 

ขอเสีย  
1. เฟรมควบคมุไดยาก หากคุณไมมีความเขาใจเพยีงพอ 
2. บาง Web Browser อาจจะไมสามารถเปดเว็บเพจที่ใช Frame ได 
3. เฟรมมีการโหลดที่ชาในครั้งแรก เพราะวา 1 หนาแสดงผลตองทําการโหลดมากกวา 1 ไฟล

เว็บเพจขึ้นไปในครั้งเดยีว 
4. เฟรมไมเปนที่สบอารมณของบรรดา Search Engine ทั้งหลาย ถาคุณคิดจะทําเว็บขายของ

หรือเว็บอะไรก็แลวแตที่ตองการใหคนเขาใชเว็บคณุมาก ๆ คงไมดีแน 
5. อ่ืน ๆ  

TopFrame 

LeftFrame 
MainFrame 
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จากเหตุผลขอเสียขางตนของเฟรม จึงอาจจะทําใหเว็บยอดนิยมหลาย ๆ เว็บ 85% ของเว็บที่ติด
อันดับ ไมนยิมใชเฟรมกับเว็บเพจ 
 
สวนประกอบของเฟรม 

1. เฟรมหลัก (Frameset) คือ หนาตางเฟรมที่ใหญที่สุด ทีค่อยควบคุมเฟรมยอยอ่ืนๆ โดยที่
หนาตางเฟรมที่กําหนดลักษณะการแบงเฟรมในแนวตั้งและแนวนอน และสามารถกําหนดคาคณุสมบัติ 
ขนาด สีของเสนของ ระยะหางระหวางเฟรมไดตามตองการ 
 
   
 
 
 
 
 

2. เฟรมยอย (Frame) คือ หนาตางเฟรมทีก่ําหนดชื่อของเฟรมแตละเฟรม โดยสามารถกําหนด
ไฟลเว็บเพจหรือเว็บไซตที่แสดงประจําเฟรมเว็บเพจไดอยางอิสระ 
 

 

 
 
 
 
 
 
ทําไมตองมชีื่อในแตละ Window 

เฟรมควรจะมช่ืีอในแตละ window เนื่องจากเมื่อทําการสราง Link หรือสราง Form ในการสง
ขอมูล จะไดอางอิง target ไดถูกตอง หลายครั้งเจอ ปญหา  เนือ่งจากการสราง Link ไมไดกําหนด
เปาหมายหรือ target ของ window ของเฟรม เมื่อไมไดกําหนด คา Default ของ target จึงเปน _self หรือ
ก็คือเปาหมายของ window คือ ตัวไฟลที่มลิีงกนั้นเอง 
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เคร่ืองมือ   
 

 
 

เครื่องมือจะมีเฟรมใหเลือกหลายรูปแบบ โดยสามารถคลิกเลือกแบบได ดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 
ขั้นตอน 

1. ใหไปที่ Main Menu -> File -> New 
 โปรแกรมจะทําการเปดหนาตางใหมขึ้นชือ่วา New Document หนาตางนี้ ใหเลือกไปที่ Tab ที่

ช่ือวา General แลวเลือก Category เปน Framesets จากนัน้ทาง List ตรงการหนาตางที่ช่ือวา Framesets: 
ใหเลือกรูปแบบของ Frame ที่ตองการใชงาน ซ่ึงรูปแบบของ Frame  จะถูก Preview ใหเห็น เมื่อเลือก
ไปที่รายการใดรายการหนึ่งที่ List Framesets ดังรูป 
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2. เมื่อไดไฟลเว็บเพจ ซ่ึงมีลักษณะเฟรมตามที่ตองการแลว จากนั้นใหทาํการ save ไฟล    ซ่ึง
การ Save ไฟลของเว็บเพจที่มีรูปแบบเปนเฟรมนี้ จะมกีารบันทึกทีแ่ตกตางจากไฟลืเว็บเพจปรกติทั่วไป 
ดังที่ไดอธิบายไปเมื่อบทความกอนวา เฟรมประกอบดวยไฟลเว็บเพจมากกวา 1 ไฟล ดังนั้นการบันทึก
ไฟลจึงตองมีมากกวา 1 คร้ังในการเว็บครั้งแรก หลังจากที่ไดทําการ Create ขึ้นมาใหม โดยมีวิธีการดังนี ้

-  ใหไปที่ Main Menu -> Save All  ดังรูป  
 
 
 
 
 
 
  
 -   เมื่อเลือกที่ Save All แลว โปรแกรมจะเริ่มดําเนินการให Save ไฟล ในการ Save คร้ังแรก
ของโปรแกรมจะเปนการ Save ไฟลที่เปน Frameset ดังรูป 
 
 
 
 
 
 
 
 
 
 

ใหสังเกตทัเ้สนขอบของจอภาพขณะบันทกึวาจะปรากฏมีเสนขีด ๆ สีดํา แบบตะเขบ็ ลอมรอบ 
Frame ทั้งหมด และที่ช่ือไฟลเร่ิมตน จะมคีําวา Frameset ปรากฏอยู นัน้แสดงวากําลังทําการ Save ไฟล
ซ่ึงเปน Frameset อยู 
 
 
 
 
  - คร้ังตอมาโปรแกรมจะดําเนินการบันทกึไฟลอ่ืน ๆ ตอไป  
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จากรูปขางตน จะเปนการ Save ไฟลที่อยูดานลางซึ่งเปน Main Frame ของเฟรม
รูปแบบนี้ใหสังเกตที่ เสนขดี ๆ สีดํา แบบตะเข็บ ลอมรอบ Frame ที่โปรแกรมกําลังจะทําการบันทกึ จะ
เห็นวาเสนนัน้จะมาลอมรอบอยูที่กรอบดานลาง นั้นแสดงวาโปรแกรมกําลังจะทําการบันทึกไฟลของ
หนาจอของเฟรมในสวนนี ้
 
การปรับขนาดของเฟรม 
 
 
 
 
 
 
 
 
 
การลบเฟรม 
 สามารถลบเฟรมที่ไมตองการออกไป โดยคลิกเมาสที่ขอบเฟรม แลวลากออกไปนอกหนาเว็บ 
ตามแนวนอนหรือแนวตั้งของขอบเฟรมที่เลือกอยู 
 
 
 
 
 
การนําหนาเวบ็มาประกอบในเฟรม 
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วิธีท่ี 1  สรางใหมลงในเฟรมที่กําหนด 
  เมื่อกําหนดแซตขึ้นมาแลว สามารถออกแบบเว็บเพจของลงแตละเฟรมไดตามที่ตองการ โดย
คลิกเลือกที่ชองเฟรมที่ตองการสราง จากนั้นทําการแทรกขอความหรือรูปภาพตาง ๆ ในในเฟรม 
 
 
 
 
 
 
 
 
วิธีท่ี 2  การแทรกเว็บเพจลงเฟรม 
 1.   คลิกเลือกเฟรมที่ตองการแทรกเว็บเพจ 
 
 
 
 
 
 2.  เลือกไฟลเว็บเพจทีเ่ตรียมไวในสวนของ Properties 
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  3. เมื่อเลือกไฟลเว็บเพจเรียบรอย รายละเอยีดจะปรากฎในเฟรมที่เลือก 
 
 
 
 
 
 
 
 
 
 
 
 
 


